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Aerobatics contributed by Grant Benns

Last   year I wrote an article on sequence design, where 
considerations about the use and placement of manoeuvres in a 
sequence was discussed. 

A poorly designed aerobatic sequence will, at-best, be a struggle 
to cleanly fly and, at-worst, be outright dangerous. The aim of 
competition aerobatics is to win, so why start on the back foot 
with a bad sequence?

Free Sequence Origins
Unfortunately, sometimes you have to work with what you 

have got, such as the prescribed ‘Known’ sequence, in which 
all competitors must fly the same sequence of manoeuvres in 
a category. Generally, these sequences have been designed by 
seasoned and experienced senior competitors, quite often in a 
small group with an appropriate name like ‘Sequence Design 
Committee’. A proposed sequence will be tested and peer reviewed 
before being released to the masses. In New Zealand, we generally 
adopt the Known sequences proposed by either the International 
Aerobatic Club (funnily enough, an American organisation) or the 
truly global organisation CIVA, after a process of peer review that 
starts along the lines of ‘whaddaya think?’!

Design Rules
More challenging for competitors is to freely design their own 

sequence, which can seem somewhat daunting at first, given the 
rules and regulations to which the sequences must abide by. As 
with other forms of motorsport, the rules are there to ensure the 
playing field is level and competitors know the boundaries in 
which they must operate - in the case of competition aerobatics 
this is to ensure the different categories from Primary to Unlimited 

Flying a display ranges from a top level competition aerobatic 
routine all the way back to a quick beat-up in front of your friends, 
or a zappy low-level impromptu hoon around (though this might only 
be something that gyro pilots your Editor associates with get up to). 
Wherever you are on this spectrum, there are some very simple 
considerations (legality notwithstanding) to keep top of mind in 
order to stay safe.
Resident KiwiFlyer Test Pilot and Aerobatic Champion Grant Benns 
has had a break over recent issues. Prior to that he wrote an 
introductory article on designing aerobatic sequences (available for 
free download online in Issue 54). 

To recap Grant’s advice via the sub-headings from that article:
1. Know each figure you intend to fly and be confident you can fly it
2. Know the entry speed range for each figure
3. Know how much height you will lose (or gain) with each figure
4. Define your height limits

5. Place figures in order of exit speed achieved to entry speed 
    required
6. Start high, finish low
7. Place energy sappers early
8. Remember to turn around
9. Consider the horizontal distance required and available 
And when you contemplate flying the sequence:
10. Create height/speed ‘gates’
11. Consider ‘outs’ or escapes
12. Don’t ad-lib

Grant continues here with a presentation of sequence design for 
competition aerobatics where a variety of rules must be accounted 
for to keep the playing field level and judging fair. The modern 
way to design a compliant sequence is (of course…) with an App 
(and in the next issue we’ll explain how to program the drone to fly 
it for you… don’t worry, kidding ). Grant writes:

Aerobatic Sequence Design
Richard Hood in Pitts Model 12 ZK-PTS. Gavin Conroy captured the image at Warbirds Over Wanaka 2014.
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have limits of difficulty that reflect the supposed skills of the pilots 
flying them, the capabilities of the typical aircraft that may be 
expected to compete, and suitable safety margins. As you would 
expect, the lower categories have more simple manoeuvres flown 
at higher altitudes, while the higher categories have progressively 
more complex manoeuvres flown to lower altitudes. For a newbie, 
there is an expectation that you start in the lower categories!

Category Differences
When confronted with designing a sequence for competition, 

you could be presented with a selection of manoeuvres you 
may not have actually flown, such as in a programme flown 
at competitions called the Free Known. In this programme, 
flown in the Intermediate, Advanced and Unlimited categories, 
competitors construct a sequence using a selection of five 
prescribed manoeuvres as well as some additional self-selected 
manoeuvres to link them nicely together. For the Recreational and 
Sports categories, you can freely select your manoeuvres however 
they must comply with the category rules in terms of difficulty 
(simplicity) and variation. 

OpenAero
The rules that govern the selection of the manoeuvres are 

somewhat complex, however I would recommend reading them 
first before moving to the design stage using the online software 
that I will describe soon. Fortunately, in recent times, several 
clever IT people, also passionate about aerobatics, have developed 
an on-line software programme called OpenAero. This portal has 
the various rules for each category built-in - it knows the limits 
of difficulty and variety, and enables you to easily manipulate the 



KiwiFlyer Magazine Issue 6030 312018 #5

Aerobatics contributed by Grant Benns

Last   year I wrote an article on sequence design, where 
considerations about the use and placement of manoeuvres in a 
sequence was discussed. 

A poorly designed aerobatic sequence will, at-best, be a struggle 
to cleanly fly and, at-worst, be outright dangerous. The aim of 
competition aerobatics is to win, so why start on the back foot 
with a bad sequence?

Free Sequence Origins
Unfortunately, sometimes you have to work with what you 

have got, such as the prescribed ‘Known’ sequence, in which 
all competitors must fly the same sequence of manoeuvres in 
a category. Generally, these sequences have been designed by 
seasoned and experienced senior competitors, quite often in a 
small group with an appropriate name like ‘Sequence Design 
Committee’. A proposed sequence will be tested and peer reviewed 
before being released to the masses. In New Zealand, we generally 
adopt the Known sequences proposed by either the International 
Aerobatic Club (funnily enough, an American organisation) or the 
truly global organisation CIVA, after a process of peer review that 
starts along the lines of ‘whaddaya think?’!

Design Rules
More challenging for competitors is to freely design their own 

sequence, which can seem somewhat daunting at first, given the 
rules and regulations to which the sequences must abide by. As 
with other forms of motorsport, the rules are there to ensure the 
playing field is level and competitors know the boundaries in 
which they must operate - in the case of competition aerobatics 
this is to ensure the different categories from Primary to Unlimited 

Flying a display ranges from a top level competition aerobatic 
routine all the way back to a quick beat-up in front of your friends, 
or a zappy low-level impromptu hoon around (though this might only 
be something that gyro pilots your Editor associates with get up to). 
Wherever you are on this spectrum, there are some very simple 
considerations (legality notwithstanding) to keep top of mind in 
order to stay safe.
Resident KiwiFlyer Test Pilot and Aerobatic Champion Grant Benns 
has had a break over recent issues. Prior to that he wrote an 
introductory article on designing aerobatic sequences (available for 
free download online in Issue 54). 

To recap Grant’s advice via the sub-headings from that article:
1. Know each figure you intend to fly and be confident you can fly it
2. Know the entry speed range for each figure
3. Know how much height you will lose (or gain) with each figure
4. Define your height limits

5. Place figures in order of exit speed achieved to entry speed 
    required
6. Start high, finish low
7. Place energy sappers early
8. Remember to turn around
9. Consider the horizontal distance required and available 
And when you contemplate flying the sequence:
10. Create height/speed ‘gates’
11. Consider ‘outs’ or escapes
12. Don’t ad-lib

Grant continues here with a presentation of sequence design for 
competition aerobatics where a variety of rules must be accounted 
for to keep the playing field level and judging fair. The modern 
way to design a compliant sequence is (of course…) with an App 
(and in the next issue we’ll explain how to program the drone to fly 
it for you… don’t worry, kidding ). Grant writes:

Aerobatic Sequence Design
Richard Hood in Pitts Model 12 ZK-PTS. Gavin Conroy captured the image at Warbirds Over Wanaka 2014.

Ga
vin

 Co
nr

oy
 im

ag
e

have limits of difficulty that reflect the supposed skills of the pilots 
flying them, the capabilities of the typical aircraft that may be 
expected to compete, and suitable safety margins. As you would 
expect, the lower categories have more simple manoeuvres flown 
at higher altitudes, while the higher categories have progressively 
more complex manoeuvres flown to lower altitudes. For a newbie, 
there is an expectation that you start in the lower categories!

Category Differences
When confronted with designing a sequence for competition, 

you could be presented with a selection of manoeuvres you 
may not have actually flown, such as in a programme flown 
at competitions called the Free Known. In this programme, 
flown in the Intermediate, Advanced and Unlimited categories, 
competitors construct a sequence using a selection of five 
prescribed manoeuvres as well as some additional self-selected 
manoeuvres to link them nicely together. For the Recreational and 
Sports categories, you can freely select your manoeuvres however 
they must comply with the category rules in terms of difficulty 
(simplicity) and variation. 

OpenAero
The rules that govern the selection of the manoeuvres are 

somewhat complex, however I would recommend reading them 
first before moving to the design stage using the online software 
that I will describe soon. Fortunately, in recent times, several 
clever IT people, also passionate about aerobatics, have developed 
an on-line software programme called OpenAero. This portal has 
the various rules for each category built-in - it knows the limits 
of difficulty and variety, and enables you to easily manipulate the 



KiwiFlyer Magazine Issue 6032

layout and substitute different manoeuvre, all while keeping a total 
of the overall difficulty score (called K).   

The best news is it is free, a term that has ring to it for pilots! 
There are no pop-up adverts or suggestions for upgrades, and you 
can play around on it, whist saving and printing your results, to 
your heart’s content. 

Step by step
As a demo/tutorial, what follows is an intro into using 

OpenAero which, I hope, will demystify another aspect of this big 
scary thing called competition aerobatics (you can also use this 
programme for drawing up your Sunday/airshow routine too). I 
would recommend having this article sitting beside your computer 
keyboard.

Open OpenAero
First of all, you will need to be on-line (on the internet) to 

get the best out of OpenAero, and the programmers recommend 
using Google Chrome too - other web browsers can cause the odd 
glitch. Search for OpenAero and you should find https://openaero.
net. When you open this website it will load OpenAero into your 
browser as an extension. Now, each time you open OpenAero on 
this computer, it will ‘remember’ you and any sequences you have 
been working on. 

There is a really good ‘help’ section accessed off the Help tab at 
the top of the page, if you need to delve deeper. 

You will want to ‘save’ your sequences, so it would pay to set up 
where you want to download your sequence file to - in Chrome 
this is done from Preferences in the Chrome menu (top left corner), 

then select Advanced and look for Downloads. You can now Change 
the place in your computer that you wish to save your completed 
sequences.  

Sequence Info
When you first open OpenAero you will be on a screen full of 

blanks spaces titled Sequence Info and Figure Editor tabs in orange. 
The start/default tab is Sequence Info. This is where you can set up 
personal data, such as name, aircraft type and registration, which 
will personalise the completed sequence sheets for use by the 
judges.

You need to select the Class (Power or Glider) and the Rules 
- for flying in New Zealand competitions select NZAC (NZ 
Aerobatic Club). You now select the Category you wish to fly, 
which will determine the complexity and variation rules - for this 
article we will use Sports. You now need to select a Programme - in 
this category your only choice is Free. You are now all set to create 
your sequence. 

Figure Editor
By clicking on the Figure Editor tab you are now in the side of 

the programme that enables you to build your chosen programme’s 
sequence of figures (manoeuvres).

You will notice an Alerts box in red/orange below the Add 
Figure area. This, effectively, represents the Rules, telling you 
what you are missing to complete the sequence in accordance 
with the underlying rules. The Family describes the different base 
manoeuvres - for example, Family 1 are lines with roll/snap or spin 
elements, Family 7 are loops, Family 8 are cuban and humpty-
bumps and so on.  

To the right of the Add Figure box is a running total of Total 
K, or difficulty factor, with the maximum K in brackets below, as 
a reminder/target. As you add figures to your sequence, the Total 
K increases by the amount of each new figure. When you have 
finished building the sequence, the Total K must be no more than 
the maximum allowable K - the Alerts box will tell you if you have 
exceeded it.

Time to add figures
Clicking anywhere in the Add figure box will bring up a 

menu of allowable figures on the right side of the screen, starting 
with 1.1 Single Lines - this is a Family 1 figure that you must 
include, somewhere in your sequence. However, just because it is 
numbered Family 1 doesn’t mean you have to use it first - you may 
elect to start with something different, like a Family 8 loop. 

At all times remember that it is in your interests to select 
manoeuvres you like, your plane likes and you are good at - this is 
your chance to design a friendly sequence which can impress the 
judges. So let’s add a good starting manoeuvre - normally a start-
high/fast manoeuvre, as this may be the only time you have speed 
and height to burn! How about a half-loop with a roll off the top? 

Figure 1
In the right-screen box, select 7.2 Half Loops, which will bring 

up a selection of different half-loop combinations that are able to 
be used. Black solid lines are the positive-G parts of a figure, while 
dashed-red lines are inverted-G portions. The half- and full-arcs 
across the main lines represent either a half-roll that must be 
completed for the figure to be flown correctly, or an optional roll 
that may be inserted in the figure. 

By clicking on the figure in column 1 of row 2 we select our 

Aerobatics

desired half-loop/half-roll and it gets displayed in the main screen, 
complete with a summary of the elements of the figure in the 
adjacent Total K box. Because it is red, we can modify it further 
if we like, for example by making the roll 1 1/2 rolls instead of a 
half-roll. This is done in the Edit Figure box, where you will find 
an option called Second Roll Position. Click on the drop-down to 
change 1/2 to 1 1/2 and the figure updates, with increased K, to 
your new selection. Do you want to do a 1 1/2 roll in your Robin? 
Probably not, so let’s change it back to a 1/2 roll!

Figure 2
Time to add a second figure - we are high and slow, and we 

must have a spin (check the Alerts) so let’s do that. A spin is 
created using a single line with a spin element, so we select 1.1 
Single Lines and search for an upright entry (black horizontal line), 
and inverted down line (the nose drops into a spin, with slightly 
negative G) and a solid black line to exit (upright = positive G). 
This will be found in column three, row six - don’t ask me why it 
is so buried, considering it is the most used and most basic spin, 
but from this you can start to see the vast array of figure variations 
available to be flown. After selecting the base element - the line 
- we now must add the spin element, from the drop-down in 
First roll/spin position menu of the edit figure box. Click on 1, for 
1 turn, and see how this is added to the figure, with the Total K 
increasing accordingly. Magic!

Wind... start direction
Above the Total K box is the wind arrow, an assumed wind 

direction. When your final sequence is saved and printed, there 
will be a form produced with the sequence shown flown in both 
assumed wind directions. The wind direction for a competition 
flight is set by the Contest Director, on the day of the comp, so 
you must have a form that the judges can use for either direction. 
When creating your sequence in OpenAero, the wind is always 
displayed right-to-left on the screen.   

Spins aren’t great to do ‘down-wind’ - they chew up a lot of 
box-space, which is only 1000m from side-to-side - so we could 
either place it somewhere else in the sequence (even start with 
it) or change the direction of our first manoeuvre so that the 
spin is flown into wind. The menu at the top of OpenAero has 
some other tabs, like File, View, Sequence, Queue and so on. 
By selecting Sequence we find an option for Downwind Entry - 
selecting this will change the entry direction of the first manoeuvre 
and therefore swap all the subsequent manoeuvres too. This can be 
switched back with the Upwind entry selection. 

2018 #5 33

Adding Figure 1 in OpenAero, a half  loop half  roll.

Convert the spin entry direction (and all preceding manoeuvres) here. 

Adding a spin for Figure 2.

Our choice of  a spin for Figure 2 has resulted in an undesirable down-wind entry.
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Changing the spin
I don’t like the one-turn spin, as it has me exiting in the wrong 

direction for what I want to do next, so while the spin figure is still 
red I can change the spin into a 1 1/2 turn spin, which has a K 
due to being easier to more accurately recover. Really! 

Figure 3
We come out of the spin low and fast, and will need to turn 

around to stay in the box. But we have a bit of room here to 
throw in an aileron roll - in fact, so much speed we can show how 
good we are by doing a 2-point roll. Select 1.1 Single Lines and 
row 1 column 1 has an upright straight a line, to which we add a 
roll by selecting the First roll drop down under the Edit Figure 3 
purple box on the left. There are a multitude of roll options, but 
a 2-point roll is called 2/2, i.e. one complete roll split into two. 
Four-point rolls follow a similar convention - a half roll flown with 
a hesitation at each 90 degree point would be shown as 2/4, while 
full 4-point roll would be 4/4. Easy?   

Now we can turn around.

Figure 4
We could do a variety of manoeuvres here, so long as we don’t 

repeat anything we have already done - a rule called No Repetition 
(the Alert box will tell you if you do repeat something). A half-
cuban? How about a stall turn? Yes, I like those and I am quite 
good at them! Stall turns are in the base family 5.2, which you can 
find on the right side of the screen and drop down. There is only 
one row, and columns 2 to 4 have either inverted starts or finishes 
or both - we don’t want to do that, so select column one, a vanilla 
stall turn. You will see small arcs through the up and down lines, 
representing places you may insert optional roles, but let’s not… 
this is only Sports and a slightly underpowered Robin. Clicking on 
column 1 selects the figure to the main screen, updating the Total 
K (to 51…only 89 K to go).

Layout
At this stage, you may want to spread our three selected figures 

out a bit, to make it easier to read. The finished sequence needs 
to fit on the page nicely, in a flow or manner that is easy to ready 
in the heat of the actual flight. OpenAero has a range of buttons 
that allows you to manipulate the layout - scaling, shrinking and 
stretching, linking etc. Clicking-and-dragging the figure you want 
to move is the easiest way to move figures around - a small dotted 
line gets drawn between the selected figure and the previous figure. 
Hovering your pointer over the various buttons in the Edit Figure 
box will allow you to explore the other options. The blue circles 
in a highlighted figure are also points you can click-and-drag to 
change the length of the various lines of a figure. Also, in the 
Figure Editor box below the First Roll/Second Roll boxes you will 
find Gaps boxes, which have a similar effect. 

With a bit of time and artistic license, the basic sequence drawn 
by the system can be changed into something much more easy to 
follow, by the pilot and the judges. An easier-to-read form may 
even improve your score…

The final result
Once you have finished inserting all the figures required by the 

rules, without exceeding the K limits, you will see no messages 
in the Alerts box. Hopefully, with great skill, you will also be at 
the maximum allowable K - this will ensure you have the best 
chance to maximise your score, as the total score for the sequence 
you fly is the individual score for each figure (a score of between 
0 and 10) multiplied by the K (difficulty factor). For Sports, the 
theoretical maximum is therefore 1400 points, being 140 (total 
maximum K) x 10 (perfection!). If you think about this some 
more, you may realise that it is best to spread the K reasonably 
evenly across your chosen figures, so that getting a bad score on 
a high-K figure doesn’t drag down your total score. In Sports, the 
maximum number of figures you may have in a sequence is 12  so 
it would not be sensible to fly just two incredibly complex figures 
of 70K each, with a high chance of scoring poorly in either, when 
you could fly 12 figures with an average closer to 12k each. Alas, 
it is practically impossible to achieve this, but it is still worthwhile 
making an attempt to both get to 11 or 12 figures AND spread 
the K evenly.

Save/Print
Click on the OpenAero File drop-down and select Save 

Sequence. This will open a Save File box, reminding you how to 
change where Chrome will save your file.

If you wish to print your forms, you have variety of options and 
formats, also found on the File drop-down menu, at the bottom. 
Click on Print/save Forms to open the dialog box.

My attempt
So, continuing on from the first four figures described above, 

I have completed a Free sequence that complies with the rules for 
the 2019 NZAC Sports rules. What do you think? Is it flyable? I 
think so, although if I flew it in a Robin or Cessna 152A I would 
plan on taking a break after figure 5 and probably after figure 9 
too. Remember, ‘breaks’ or interruptions, used to climb higher and 
regain energy before recommencing the sequence, are ‘cheap’ - the 
penalty is only 10 points for each break in Sports, so two breaks 
will only penalise you by 20 points out of a total of 1400 potential 
points. Given you are more likely to fly the subsequent figures 
following a break with more energy that comes from the regaining 
your star height, and thus score better, it is a highly recommended 
strategy to take planned breaks. Of-course, an aircraft such as 
an RV6/7/8, Pitts or G202 should eat this sequence without 
stopping, although maybe not in a winning way - many a well-
flown lesser aircraft has beaten high-performance aircraft over the 
years. 

You can do it too.   
              Grant Benns
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Aerobatics

A 2 point roll for Figure 3.

And a stall turn for Figure 4.

Grant’s completed sequence, ready to fly for a max K of  140.

At right: Doug Brooker performing in his MXS.
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NEW!    COPILOT 1 Airspeed Monitor

Connects to your pitot and static airdata lines and intercom.

Configure via USB (Windows PC) or Bluetooth (Android phone).

‘Head up, 
eyes out’

Calls out airspeed during 
critical phases of flight 

l take-off / climbout 
l approach / landing 

l overspeed
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Changing the spin
I don’t like the one-turn spin, as it has me exiting in the wrong 

direction for what I want to do next, so while the spin figure is still 
red I can change the spin into a 1 1/2 turn spin, which has a K 
due to being easier to more accurately recover. Really! 

Figure 3
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around to stay in the box. But we have a bit of room here to 
throw in an aileron roll - in fact, so much speed we can show how 
good we are by doing a 2-point roll. Select 1.1 Single Lines and 
row 1 column 1 has an upright straight a line, to which we add a 
roll by selecting the First roll drop down under the Edit Figure 3 
purple box on the left. There are a multitude of roll options, but 
a 2-point roll is called 2/2, i.e. one complete roll split into two. 
Four-point rolls follow a similar convention - a half roll flown with 
a hesitation at each 90 degree point would be shown as 2/4, while 
full 4-point roll would be 4/4. Easy?   

Now we can turn around.

Figure 4
We could do a variety of manoeuvres here, so long as we don’t 

repeat anything we have already done - a rule called No Repetition 
(the Alert box will tell you if you do repeat something). A half-
cuban? How about a stall turn? Yes, I like those and I am quite 
good at them! Stall turns are in the base family 5.2, which you can 
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At this stage, you may want to spread our three selected figures 
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in a highlighted figure are also points you can click-and-drag to 
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With a bit of time and artistic license, the basic sequence drawn 
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follow, by the pilot and the judges. An easier-to-read form may 
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in the Alerts box. Hopefully, with great skill, you will also be at 
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you fly is the individual score for each figure (a score of between 
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it would not be sensible to fly just two incredibly complex figures 
of 70K each, with a high chance of scoring poorly in either, when 
you could fly 12 figures with an average closer to 12k each. Alas, 
it is practically impossible to achieve this, but it is still worthwhile 
making an attempt to both get to 11 or 12 figures AND spread 
the K evenly.
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Sequence. This will open a Save File box, reminding you how to 
change where Chrome will save your file.

If you wish to print your forms, you have variety of options and 
formats, also found on the File drop-down menu, at the bottom. 
Click on Print/save Forms to open the dialog box.
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I have completed a Free sequence that complies with the rules for 
the 2019 NZAC Sports rules. What do you think? Is it flyable? I 
think so, although if I flew it in a Robin or Cessna 152A I would 
plan on taking a break after figure 5 and probably after figure 9 
too. Remember, ‘breaks’ or interruptions, used to climb higher and 
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penalty is only 10 points for each break in Sports, so two breaks 
will only penalise you by 20 points out of a total of 1400 potential 
points. Given you are more likely to fly the subsequent figures 
following a break with more energy that comes from the regaining 
your star height, and thus score better, it is a highly recommended 
strategy to take planned breaks. Of-course, an aircraft such as 
an RV6/7/8, Pitts or G202 should eat this sequence without 
stopping, although maybe not in a winning way - many a well-
flown lesser aircraft has beaten high-performance aircraft over the 
years. 

You can do it too.   
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